Adobe® Dreamweaver® CS5
The Professional Portfolio
About Against the Clock

Against The Clock, long recognized as one of the nation’s leaders in courseware development, has been publishing high-quality educational materials for the graphic and computer arts industries since 1990. The company has developed a solid and widely-respected approach to teaching people how to effectively utilize graphics applications, while maintaining a disciplined approach to real-world problems.

Having developed the Against The Clock and the Essentials for Design series with Prentice Hall/Pearson Education, ATC drew from years of professional experience and instructor feedback to develop The Professional Portfolio Series, focusing on the Adobe Creative Suite. These books feature step-by-step explanations, detailed foundational information, and advice and tips from industry professionals that offer practical solutions to technical issues.

Against The Clock works closely with all major software developers to create learning solutions that fulfill both the requirements of instructors and the needs of students. Thousands of graphic arts professionals — designers, illustrators, imaging specialists, prepress experts and production managers — began their educations with Against The Clock training books. These professionals studied at Baker College, Nossi College of Art, Virginia Tech, Appalachian State University, Keiser College, University of South Carolina, Gress Graphic Arts Institute, Hagerstown Community College, Kean University, Southern Polytechnic State University, Brenau University, and many other educational institutions.

About the Author

Erika Kendra holds a BA in History and a BA in English Literature from the University of Pittsburgh. She began her career in the graphic communications industry as an editor at Graphic Arts Technical Foundation before moving to Los Angeles in 2000. Erika is the author or co-author of more than twenty books about Adobe graphic design software. She has also written several books about graphic design concepts such as color reproduction and preflighting, and dozens of articles for online and print journals in the graphics industry. Working with Against The Clock for more than ten years, Erika was a key partner in developing the Portfolio Series of software training books.

Contributing Artists and Editors

A big thank you to the people whose artwork, comments, and expertise contributed to the success of these books:

- Greg Forquer
- Rick Schrand, Nossi College of Art
- Doug Borton, Kellogg Community College
- Ben Hannam, Virginia Tech
- Debbie Davidson, Sweet Dreams Design

Special thanks also to the companies whose sites are used in this book:

- Biltmore Village Inn, www.biltmorevillageinn.com
- Apple Homes, www.applehomesfla.com
- Moxie Photographic Studios, www.moxiestudios.com

Finally, thanks to Angelina Kendra, editor, for making sure that we all said what we meant to say.
Project Goals
Each project begins with a clear description of the overall concepts that are explained in the project; these goals closely match the different "stages" of the project workflow.

The Project Meeting
Each project includes the client's initial comments, which provide valuable information about the job. The Project Art Director, a vital part of any design workflow, also provides fundamental advice and production requirements.

Project Objectives
Each Project Meeting includes a summary of the specific skills required to complete the project.

Real-World Workflow
Projects are broken into logical lessons or "stages" of the workflow. Brief introductions at the beginning of each stage provide vital foundational material required to complete the task.

Step-By-Step Exercises
Every stage of the workflow is broken into multiple hands-on, step-by-step exercises.

Visual Explanations
Wherever possible, screen shots are annotated so you can quickly identify important information.
Dreamweaver Foundations
Additional functionality, related tools, and underlying graphic design concepts are included throughout the book.

Advice and Warnings
Where appropriate, sidebars provide shortcuts, warnings, or tips about the topic at hand.

Project Review
After completing each project, you can complete these fill-in-the-blank and short-answer questions to test your understanding of the concepts in the project.

Portfolio Builder Projects
Each step-by-step project is accompanied by a freeform project, allowing you to practice skills and creativity, resulting in an extensive and diverse portfolio of work.

Visual Summary
Using an annotated version of the finished project, you can quickly identify the skills used to complete different aspects of the job.
The Against The Clock Portfolio Series teaches graphic design software tools and techniques entirely within the framework of real-world projects; we introduce and explain skills where they would naturally fall into a real project workflow. For example, rather than including an entire chapter about site management, we teach site management where you naturally need to do so — when you begin building a new site in each project.

The project-based approach in the Portfolio Series allows you to get in depth with the software beginning in Project 1 — you don’t have to read several chapters of introductory material before you can start creating finished artwork.

The Portfolio Series project-based approach also prevents “topic tedium” — in other words, we don’t require you to read pages and pages of information about marking up text (for example); instead, we explain text-related mark-up as part of a larger project (in this case, as part of a digital book chapter).

Clear, easy-to-read, step-by-step instructions walk you through every phase of each job, from creating a new file to saving the finished piece. Wherever logical, we also offer practical advice and tips about underlying concepts and graphic design practices that will be important as you enter the job market.

The projects in this book reflect a range of different types of Dreamweaver jobs, from creating a digital portfolio to developing a functional site template to building an online registration page. When you finish the eight projects in this book (and the accompanying Portfolio Builder exercises), you will have a substantial body of work that should impress any potential employer.

The eight Dreamweaver CS5 projects are described briefly here; more detail is provided in the full table of contents (beginning on Page viii).
Some experts claim most people use only a small fraction — maybe 10% — of their software’s capabilities; this is likely because many people don’t know what is available. Our goal is to familiarize you with the entire tool set so you can be more productive and more marketable in your career as a graphic designer.

It is important to keep in mind that Dreamweaver is an extremely versatile and powerful application. The sheer volume of available panels, options, and features can seem intimidating when you first look at the software interface. Most of these tools, however, are fairly simple to use with a bit of background information and a little practice.

Wherever necessary, we explain the underlying concepts and terms that are required for understanding the software. We’re confident that these projects provide the practice you need to be able to create sophisticated artwork by the end of the very first project.
### Contents

#### Acknowledgements iii

#### Walk-Through iv

#### Getting Started xiv

#### The Dreamweaver User Interface 1

- Explore the Dreamweaver Interface .............................................. 1
- Create a Saved Workspace ......................................................... 6
- Customizing Dreamweaver Behavior ............................................. 8
- Explore the Dreamweaver Document Window ............................... 9
- Preview Files in Dreamweaver Live View ...................................... 15
- Preview a File in a Browser ....................................................... 18
- Remove a Site from Dreamweaver .............................................. 20

#### Project 1 Moxie Digital Portfolio 21

##### Stage 1 Exploring Site Structure ............................................ 23
- Create a New Site Definition .................................................... 23
- Examine the Site Files ............................................................. 24
- Plan Folder Organization ......................................................... 26
- The Files Panel in Depth ......................................................... 28
- Sort and Move Image Files ....................................................... 28

##### Stage 2 Organizing the Site Navigation .................................... 32
- Create Links Using the Hyperlink Button .................................... 33
- The Common Insert Panel in Depth ........................................... 34
- Create a Link Using the Browse for File Function ......................... 36
- Create a Link Using the Point to File Function ............................. 37
- Shift-Drag to Create a Link ..................................................... 37
- Adjust Relative Link Paths ....................................................... 38
- Copy and Paste Links ............................................................. 40
- Create Email and External URL Links ....................................... 42

##### Stage 3 Creating Image Links ................................................. 43
- Create Image Links ............................................................... 43
- Copy and Paste Image Links .................................................... 45
- Create Image Map Links ........................................................ 47

##### Stage 4 Naming and Titling Documents .................................... 49
- Rename Default Pages .......................................................... 49
- Rename Portfolio Pages for Improved Usability ............................ 51
- Create Document Titles for the Portfolio Pages ............................ 53
- Add Specific Page Information in the Document Title .................... 56
- Hide Files from the Web Server ............................................... 57
- Export and Remove the Site Definition ...................................... 59

#### Project Review ................................................................. 60

#### Portfolio Builder Project ..................................................... 61
## Project 2  Digital Book Chapter 63

### Stage 1  Preparing the Workspace
- Define the ATC Site ............................................ 65
- Create a New HTML Document .............................. 66

### Stage 2  Working with Special Markup
- Paste Text Content in Design View .......................... 68
- Formatting Text with the Properties Panel .................. 71
- Format Headings in Design View ........................... 72
- Creating an Unordered List of Navigation Links .......... 79
- Creating a Definition List ..................................... 81
- Using Special Characters in Code View ............. 83
- Understanding Code View Formatting ....................... 80
- Marking up Acronyms in Design View .................. 81
- Formatting Text with the Properties Panel ............... 83

### Stage 3  Working with Special Characters
- Insert Special Characters ................................... 85
- Understanding Named Anchors ................................ 87
- Create a Table of Quote Characters ...................... 88
- Using the Insert Other Character Dialog Box ........ 90
- Inserting Special Characters in Code ............. 93

### Stage 4  Creating Lists
- Create a Definition List ................................... 94
- Create an Ordered List of Web Resources ............ 96
- Create an Unordered List of Navigation Links ....... 97

### Stage 5  Attaching an External CSS File
- Add div Tags and Element IDs .......................... 98
- Attach the CSS File ........................................ 100
- Identify the List as a Navigation Bar ....... 101
- Project Review .............................................. 105
- Portfolio Builder Project ................................. 106

## Project 3  Biltmore Web Site 109

### Stage 1  Working with Static Images
- Define the Biltmore Site .................................. 111
- Insert Graphic Text Using the Common Insert Panel ... 112
- Replace One Image with Another ......................... 113
- The Image Properties Panel in Depth .............. 114
- Insert an Image from the Files Panel .................. 115
- Identifying an Image Link with the Title Attribute ... 117
- Inserting an Image with an Empty Alt Attribute ... 120
- File Formats for Web Graphics ...................... 121
## Contents

### Stage 2  Editing Images in Dreamweaver
- Crop an Image .................................................. 122
- Resize, Resample, and Sharpen an Image ....................... 124
- Finish the Alabama Room Photo Gallery ....................... 127
- Index vs. Alpha Transparency .................................. 128
- Set Image Transparency ....................................... 129

### Stage 3  Controlling Backgrounds with CSS
- Insert a Background Image in the Footer ...................... 131
- Set the Background Color of the Navigation Bar ............. 135
- Hexadecimal Color Codes ..................................... 136
- Use Background Repeat and Position Properties ............. 138

### Stage 4  Working with Other Image Types
- Insert a Flash Animation ...................................... 142
- Insert and Configure a Flash Slideshow ....................... 145
- Insert a Flash Video ........................................... 147
- Add a Favicon .................................................... 149
- **Project Review** ............................................... 151
- Portfolio Builder Project ...................................... 152

## Project 4  Apple Homes Site Layout

### Stage 1  Planning a Web Site
- Define the Apple Homes Site ................................ 157
- Create a New Web Page ......................................... 158
- The Page Properties Dialog Box in Depth ................... 160
- Insert Tables in a Web Page ................................ 161
- Tables vs. CSS .................................................... 162
- Create a Nested Table ......................................... 164
- Insert Images into Tables ..................................... 166
- Insert Rollover Images ......................................... 167
- Create the Remaining Nested Table Structure ............... 169
- The Modify>Table Menu in Depth .............................. 172

### Stage 2  Working with Templates
- Create a Template .............................................. 174
- The Insert>Template Objects Menu in Depth ................. 175
- Create a Page from a Template ................................ 177
- Apply a Template to Existing Pages .......................... 180
- The Modify>Templates Menu in Depth ....................... 182

### Stage 3  Working with Snippets
- Create a Snippet ............................................... 183
- Modify the Template File ...................................... 185
- Complete the Home Page Design ............................... 186
- **Project Review** ............................................... 190
- Portfolio Builder Project ...................................... 191
Stage 1 Creating Layouts with Style Sheets
- Define a Tracing Image
- Create an External CSS File
- The CSS Styles Panel in Depth
- Create ID Selectors
- The CSS Rule Definition Dialog Box in Depth
- Create a Layout with Div Elements
- Use the Float Property to Control Nested Divs
- Comparing the <span> and <div> Tags
- Define Properties for the <body> Tag
- Edit CSS Rules to Adjust the Layout
- Understanding the CSS Box Model
- Save the Design Template
- Place Common Page Content
- Apply the Site Template
- CSS Mode of the Properties Panel

Stage 2 Using CSS to Control Content
- Define HTML Tag Selectors
- Create Compound Tag Selectors
- Create Pseudo-Class Selectors
- Project Review
- Portfolio Builder Project

Project 6 AppleOne Registration Form
Stage 1 Creating Online Forms
- Create a Form Element
- The Form Properties Panel in Depth
- Processing Form Data
- Create Text Fields
- The Input Tag Accessibility Attributes Dialog Box in Depth
- Modify Text Field Properties
- The Text Field Properties Panel in Depth
- The File Field Properties Panel in Depth
- Create a File Field
- Create Menu Fields
- The List/Menu Properties Panel in Depth
- Create a List Field
- Create Check Boxes in a Group
- Create a Single Check Box
- Add Submit and Reset Buttons
- The Check Box Properties Panel in Depth
- The Button Properties Panel in Depth
### Contents

**Stage 2**  
**Formatting Forms with CSS**  
- Apply Style to the Form Tag ................................................................. 263  
- Use Selectors to Control Specific Form Objects ....................................... 266  
- Use Class Selectors to Control Alignment ............................................... 268  
- Dreamweaver’s Validation Widgets ......................................................... 271

**Stage 3**  
**Validating Forms**  
- Add a Spry Radio Button Group ............................................................ 272  
- Add Text Field Validation ................................................................. 277  
- Spry Validation Widget Properties ....................................................... 280  
- Insert Check Box Validation ............................................................... 283  
- Add Spry Password Validation ............................................................. 285  
- Project Review ....................................................................................... 287

**Portfolio Builder Project** ........................................................................ 288

**Project 7**  
**California Tourism Site**  

<table>
<thead>
<tr>
<th>Stage 1</th>
<th>Creating AP Divs</th>
<th>293</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>Define a Fixed Background Image</td>
<td>293</td>
</tr>
<tr>
<td></td>
<td>Insert AP Divs</td>
<td>295</td>
</tr>
<tr>
<td></td>
<td>Use the Drawing Method to Create an AP Div</td>
<td>298</td>
</tr>
<tr>
<td></td>
<td>Create Nested Divs</td>
<td>301</td>
</tr>
<tr>
<td></td>
<td>The AP Elements Panel in Depth</td>
<td>302</td>
</tr>
<tr>
<td></td>
<td>Control Properties of Nested AP Divs</td>
<td>305</td>
</tr>
</tbody>
</table>

**Stage 2**  
**Working with Spry Layout Objects**  
- Create a Spry Menu Bar ................................................................. 306  
- Modify Menu Subitems ................................................................. 308  
- Manually Edit Menu Bar List Items .................................................. 311  
- Use the Code Navigator to Review Related Styles .............................. 314  
- Manually Edit CSS Selector Code .................................................... 315  
- Use Code Hints to Write CSS Code .................................................. 317  
- Use Live View to Review Behavior .................................................. 319  
- Change Z-Index Values to Control Stacking Order ......................... 322  
- Create a Spry Tabbed Panel ............................................................ 323  
- Format Tabbed Panels ................................................................. 325  
- Using Inspect Mode in Live View .................................................... 327  
- Add Spry Tooltips ............................................................................. 328  
- Disabling CSS Styles ........................................................................ 330  
- Device-Specific Cascading Style Sheets ............................................. 331  
- Understanding Other Layout Options ............................................... 332

**Project Review** ............................................................................. 333

**Portfolio Builder Project** .................................................................... 334
Project 8  Just Posters Dynamic Site 337

Stage 1  Preparing to Use PHP and MySQL ............................................. 339
  Set up a MySQL Database ......................................................... 341
  Import the SQL Database ....................................................... 343
  Understanding MySQL Field Types ........................................... 345
  Prepare the Site Structure ...................................................... 346

Stage 2  Defining a PHP Site Definition .................................................. 348
  Create the Site Definition ...................................................... 348
  Upload Files to a Remote Site ................................................ 351

Stage 3  Creating Data-Driven Pages ...................................................... 353
  Create the MySQL Connection ............................................... 353
  Display Records from the Database ......................................... 355
  Checking Capitalization ......................................................... 355
  Server Behaviors in Depth ..................................................... 358
  Add Data Placeholders in a PHP Page ...................................... 359
  Use a Binding to Dynamically Define Alt Text .......................... 361
  Displaying Images from a MySQL Database ............................ 361
  Repeat a Recordset ............................................................... 363
  Add Recordset Navigation to the Gallery .................................. 365
  Create a Dynamic Page Link .................................................. 366
  Create the Poster Details ...................................................... 368
  Troubleshoot Dynamic Pages for Testing ............................... 372
  Add a Search Feature ............................................................. 374
  Show and Hide Regions Based on Recordset Contents ............... 377
  Display Records with Advanced Filter Criteria ......................... 379
  Synchronize the Local and Remote Sites .................................. 382
  Creating Database Administration Pages ................................ 384

Project Review ........................................................................ 387

Portfolio Builder Project .......................................................... 388